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s[ntroduction

Hardware

The Universal Computer Spectrometer offers a unique solution for nuclear spectrometry
using the PC platform. A 2K ADC combined with 8K of data memory and multi-channel
scaling is ideally suited to scintillation spectroscopy and time related studies such as half-
life decay.

Constructed in a sturdy, fully-shielded bench top enclosure with Universal Serial Bus
(USB) computer interface, the multi channel analyzer contains many advanced features
including computer controlled amplifier and high voltage for PM tubes, upper and lower
level discriminators, on instrument data memory, and a comprehensive software package
for use under Windows 98 or higher. (Windows 95 may be used if you have installed the
USB patch.)

The UCS-20 requires only an available USB port and is designed to work seamlessly
with USB-equipped PCs. For stability and low noise operation, the unit is AC-line
powered with an auto-sensing power supply for 100-250 VAC operation. An on-board
microprocessor acts as the master controller and data storage device, as well as the
communication link directly to the USB interface.

The integrated amplifier and high voltage are fully compatible with most standard
scintillation detectors, eliminating the need for special tube bases and external modules.
For ease of setup and calibration, coarse gain, fine gain, high voltage, and lower and
upper level discriminator settings are controlled directly from the desktop computer. For
operation with other types of detector systems such as alpha spectrometers or single
photon counting, a DIRECT input is provided to bypass the scintillation amplifier and
allow direct access to the ADC.

A 2048 channel ADC with de-randomizing buffer offers excellent data throughput at high
counting rates with minimal dead-time losses. Conversion gain may be changed from
2048 to 1024 to 512 or 256 channels via the software. Data from the ADC is stored
directly in on-board memory for autonomy and high-speed operation, freeing the host
computer for other tasks.

Software

The UCS-20 produces a high-resolution, real-time live color display of spectral data with
standard PC graphics running under Windows (95 and above). Operation is intuitive

“IDH_INTRODUCTION
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using pull-down menus and function buttons for the most commonly used commands and
display options. The software offers full control of all features including preset live/real
time, and regions-of-interest together with centroid, gross and net area calculations.

Control of the hardware amplifier, high voltage, ADC and input discriminators is also
through function buttons for straightforward calibration and operation. To simplify
identification of peaks, the cursor may be calibrated to read directly in energy units, using
either a 2-point linear, or 3-point quadratic relationship to allow for detector non-
linearity.

Spectral files may be transferred to disk for long-term storage as binary files or
transferred through the clipboard in ASCII format for exporting to other programs. Stored
files may be used to collect background data over a long counting period that can be
subtracted on a time proportional basis from the spectral data.

To aid in the identification of nuclides, the UCS-20 contains a unique peak-labeling
feature named ISOMATCH. Providing the unit is accurately energy calibrated, the user
may select a nuclide from the library and the corresponding characteristic emission lines
are superimposed on the spectrum along with isotope and energy information. Using this
feature, users may quickly check a spectrum and visually identify the emission
components for each nuclide present. The ISOMATCH libraries may be created or
customized using a text editor.

When operating in multi channel scaling mode, the system may be calibrated in time
units for direct readout from the cursor.

Both linear and logarithmic vertical display ranges are included which can be useful
when performing decay studies

Spectrum files, can be transferred from the ICS 10 DOS program and the ICSW 16
Windows program to the UCS20 Windows version.

Most functions may be accessed by more than one method. All the functions can be
accessed from the Pull Down Menu, some from the Tool Bar Buttons, or by the mouse. If
the function has a Tool Bar Button, its symbol will be shown on the left hand side of the
description.



sScreen View

_&._Spe-::trum Techniquez - UC520 - Live Mode
ili?;'_ﬂt Mode  Display Eettu']gs

213.3 keV

Energy: 662 kel Gross: FluyHM:
Coumts:a et Centroid:
Ready HvEIOON  [LT:38 RT:43 Device SN:36 7
“IDH_INTROSCREENVIEW

$Screen View
K .
Screen View



snstallation

System Requirements

The UCS20 instrument uses a Universal Serial Bus (USB) to communicate with a PC.
The PC must have USB compatible drivers, which are available standard on Windows 98
and later releases. Windows 95 must have the USB upgrade or patch to work. The
performance of the USB on older systems may affect the perceived performance of the
software; so we recommend that you use a Pentium 2 or greater class of microprocessor
running at 250 mHz or greater to achieve desirable performance. The executable code is
less than 600 kb, but the help files are more than 5 mb; so if you have limited disk space,
you may wish to leave the help files on the CD.

Installing Software
Connections On Rear Panel

Uninstalling Software

IDH_INSTALLATION
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sConnections On Rear Panel

The UCS-20 is equipped with an internal Amplifier/Preamplifier allowing direct
connection of a scintillation detector. If you plan to use this feature, connect the signal
(anode) output of the detector tube base to the PREAMP IN connector on the rear of the
instrument using a BNC cable and connect the high voltage to HIGH VOLTAGE with
the MHV cable

These cables appear similar with the MHV being slightly longer than the BNC

WARNING -« ELECTRICAL SHONCK HAZARD

TO AVOID ANY POSSIBLILITY OF ELECTRICAL
SHOCK, ALWAYS TURN OFF THE INSTRUMENT
POWER BEFORE CONNECTING THE EXTERNAL
CABLES, DANGEROUS HIGH VOLTAGE CAN EXIST
ON THE EXTERNAL HY CONNECTOR WHEN THE
UNIT IS OPERATING. NEVER REMOVE OR
CONNECT CABLES WITH THE INSTRUMENT
RUNNING.

SERVICE BY AUTHORIZED PERSONNEL ONLY.
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Rear Panel

HYV Output: MHV (or optional SHV) connector supplies positive 0 - 2500 volt @ 1mA
maximum current to power scintillation detector. High voltage is fully regulated and
computer controlled in 25 volt increments.

PREAMP IN: BNC connector for direct connection to PMT anode signal. Uses internal
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amplifier/preamp.
AMP IN: BNC connector for signal connection to external preamplifier.

DIRECT IN: BNC connector for connection to external amplifier. Bypasses internal
amplifier and connects directly to ADC input. Accepts unipolar or bipolar signals
0-8volt range.

EXT MCS: BNC connector to input positive MCS TTL pulses > 150nsec. 5 MHz
maximum rate.

ROI OUT: BNC connector supplies a pulse out when data is acquired in a channel
marked as a ROI. The pulse width is adjustable from 100usec to 25 msec by an internal
pot. The pulse amplitude is adjustable from Ovolt to 7.5 volts by an internal pot.

GATE IN: BNC connector for connection to external coincidence unit. A positive TTL
pulse causes the ADC to accept the next pulse. The Gate pulse must be present before the
peak of the input Pulse. Gate pulse width = 50nsec to 2usec.

MSB OUT: (OPTIONAL) BNC connector to output the most significant MCS bit for
Mossbauer Applications.

T/COMP: Modular connector for connection to temperature compensated tube base.

HIGH VOLTAGE: MHV (OPTIONAL SHV) connector supplies positive 0 to 2500
volts to power scintillation detectors and proportional tubes. 1-Watt maximum Power
available.

USB: Universal Serial Bus connector for communication with computer.

PREAMP POWER: (OPTIONAL) DB-9 connector, supplies + — 12v power for
External preamplifier.

When using an external amplifier system, connect the amplifier unipolar or bipolar output
to the DIRECT IN connector.



~Installing Software

Insert the included CD in your CD-ROM drove. The install program will automatically
run. Follow the instructions to select the options you want to install.

The application is less than 600 kb, but the help files are greater than 3 mb; if you have
limited disk space, you may not want the help file installed. You can access the help file
on the CD.

The default installation directory is C:\SpecTech\UCS20
Example files

Spectrum (*.spu) files:
Normal.spu — contains an uncalibrated spectrum of CS-137.
Calibrated.spu — contains a calibrated spectrum of CS-137.

Setup (*.sup) files:
Normal.sup — has settings used in Normal.spu.
Calibrated.sup — has settings used in Calibrated.spu.

Library (*.itm) files
Isotopes.itm — contains a list of common isotope peaks for use with the IsoMatch
function.

“IDH_INSTINSTALLINGSOFTWARE
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~Uninstalling Software

Go to the Windows Start Menu, select Settings, then Control Panel. On the Control Panel,
select Add/Remove Software. Find UCS20, double click and follow the instructions.

“IDH_INSTUNINSTALLINGSOFTWARE
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=Analysis Modes

| Maode
v Pulse Height
Mulki Channel Scaling
External MCS

See:

Pulse Height Analysis
Multi Channel Scaling
External Multi Channel Scaling

"IDH_MODES
$Analysis Modes
X Analysis Modes



~Pulse Height Analysis

! Mode
v Pulse Height

Multi Channel Scaling
Extermal MCS

This is the normal operating mode for collecting sample gamma emission spectra. The
amplitude of each detector pulse is measured by the ADC and stored as an amplitude
(energy) spectrum.

The X axis is scaled to the selected channels and the Y axis is scaled for the counts for
each channel. Y axis counts that exceed the maximum Y axis value are ‘wrapped’, they
no longer are scaled to the Y axis, and they appear in a different color.

"IDH_MODESPHA
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sMulti Channel Scaling
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Multi Channel Scaling mode is used for measuring time related phenomena such as half-
life decay or single photon counting. The ADC is bypassed and incoming events are
routed directly into memory for specific predetermined times (dwell time) and stored in
sequential memory locations.

To use this mode, first acquire a spectrum using the Pulse Height Analysis mode. While
acquiring the spectrum, adjust the LLD and the ULD to select the energy range of interest
(for example, selecting only the 662 keV peak form CS-137 can eliminate unwanted
background and produce a superior decay curve when using a Cs-137/Ba-137 mini-
generator.)

_ Mode

Fulse Heighk
v Mulki Channel Scaling
| External MCS

Click the Mode menu and select MCS
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Select Device
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Click the Settings menu and select MCS

Craall Tima
|'I 0 ms

Enter the Dwell Time. This time is for each memory location (channel). Remember the
total pass time will be (Conversion Gain x Dwell Time).

Erase any current memory data and click start. The UCS20 will proceed to count
incoming events for the selected dwell time, store the total in the first channel location,
reset the counter and repeat the cycle storing each total in sequential channels.



sExternal Multi Channel Scaling

Made

Pulse Height
MUkl Channel Scaling
v External MCS

If you wish to use an external pulse generation system such as a coincidence circuit, it
will be necessary to bypass the on-board amplifier and discriminators. Connect the
external counts connector to the Ext MCS connector on the back of the instrument and
select the menu item MODE then select External MCS.

When operating in this mode, the MCS input requires positive TTL signals (>2.5v, >150
ns duration).

“IDH_MODESEXTERNALMCS
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Screen View
Live Mode
File Mode

Amp/HV/ADC
Presets

Go, Stop and Erase
Region of Interest (ROI)
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s<[_1ve Mode
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The software starts up in the Live Mode. This mode uses the USB to communicate with
the instrument.

If you access the File Menu and click on Open, a new window appears which looks like
the current window, except that the title bar shows ‘File Mode’ instead of ‘Live Mode’.
File mode does not communicate with the instrument and is used only to view and
manipulate files that have been saved to disk.
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s<Hile Mode
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File Mode is accessible from the live mode by going to the File Menu and clicking on
Open. Select the file you want to view. Some functions, which have no use when viewing
files, are disabled in the Menus and the Toolbar.

IDH_FILEMODE
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sAmp/HV/ADC
4

Click the Amp/HV/ADC Button on the toolbar:

| Settings
I ROls 3
I Energy Calibrate »
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Select Device

Reset All Yariables To Defaults

Or use the settings menu and click on Amp/HV/ADC

Armp fHY a0 Setlings

High allegs Carvsergion s
a1 = » ﬁ
|.|:|.| El o
concor £l
Comrse Gein LLIs
- - =
-2 2 =
L |
-4 UL
e |1I'II'I il
I
|| 64 T oR |
Fina Gamn 1->2 85 Cancel
|E 25
Heln

The Amp/HV/ADC dialog box will appear.

Adjustments may be made to the amplification, high voltage, conversion gain, low level
discriminator, and the high level discriminator.

“IDH_SETTINGSAMP/HV/ADC
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Selecting OK will cause these values to be written to the UCS20 instrument.

Configuring System Parameters:
Once the program is running it will be necessary to configure the system parameters for
correct operation and calibration.

Place a gamma emitting check source near the detector face. Cesium-137 (Cs-137) is a
good choice. It has single peak at 662 keV.

Click on Settings, then click on Amp/HV/ADC
Set the high voltage to the voltage as listed by the detector manufacturer. As an example,
set the high voltage to 600 volts, click ON.

DO NOT exceed the maximum high voltage rating of the detector, usually 1200 volts.

Set the amplifier COARSE GAIN to 8, and set the FINE GAIN to 1 as a starting
position. Click on OK, to set adjustments and exit the menu.

Start the data acquisition and adjust the amplifier gain until the 662 keV peak is
approximately mid-scale.

Once the acquisition is started, you may enter the Amp/HV/ADC menu, make
adjustments while viewing the spectrum. This will allow you to
position the peak in the desired channels.

High Voltage
Amplifier Coarse Gain
Amplifier Fine Gain
ADC Conversion Gain

Lower and Upper Level Discriminators



"*High Voltage
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High Voltage may be entered directly in the text box or may be scrolled to the value
desired. A warning will be issued if you attempt to input a value higher than 1200 volts,
since this is the highest value that many probes can tolerate without damage. If you know

that your probe can accept higher than 1200 volts, you may increase the voltage up to
2500 volts.

See also:
Amp/HV/ADC
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" Amplifier Coarse Gain
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Amplifier coarse gain may be set by clicking the radio-button next to the desired
multiplier.

See also:
Amp/HV/ADC
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" Amplifier Fine Gain
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Amplifier fine gain may be directly entered as a multiplier value between 1.0 and 2.55.

See also:
Amp/HV/ADC
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“K ADC Conversion Gain
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Conversion Gain represents the number of channels that will be sampled and displayed
on the screen. Smaller values save as smaller files

The conversion gain default setting is 1024 channels. This is preferred for most
scintillation detector applications and generally no adjustment is required.

For certain applications, such as alpha spectroscopy, it may be necessary to change this
parameter to either 256, 512, or 2048 channels.

See also:
Amp/HV/ADC
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"*Lower and Upper Level Discriminators
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LLD and ULD, Lower Level Discriminator, and Upper Level Discriminator, allow the
user to set a value between 0 and 106 (roughly percent) that cuts off signal before it gets
to the ADC. The LLD is often used to block high-count signals in the low range that are
not of interest, but require excessive time to sample. The ULD may be set up to 106.
Low level discrimination (LLD) may be scrolled or directly entered.

Upper level discrimination (ULD) may be scrolled or directly entered.

L

1418 key

An alternative method to change the LLLD and ULD is to use the mouse to move the
triangles under the X axis. Move the mouse over the triangle to be moved, press the left
button, drag the triangle and release it where desired. The software will not allow the
LLD and the ULD set outside appropriate ranges.

See also:
Amp/HV/ADC
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sPresets

Preset Time
The real time count and the live time count may be changed using the Preset function.

Preset Integral
The instrument can be set to stop automatically after a ROI integral.

O

Click the Preset Time Button on the toolbar:

L e |
e

Click the Preset Integral Button on the toolbar:

Sethings
B Rols 3
! Energy Calibrate 2

Presets F
ArnpHYAEC
MES

Colors

Select Device

Reset 4l Yariables To Defaults

Or use the settings menu and click on Presets
For details see:

Preset Time
Preset Integral
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#kPreset Time

Preset Time |

{* Real Time
i Live Time

[123

Cancel |

Preset Live Time provides automatic correction for counting losses caused by the system
deadtime. Events which occur during the pulse processing cycle are lost to the system so
the timer is automatically updated to compensate for these losses. When operating at
excessively high count-rates the deadtime meter will indicate a high value and the real
counting time may be more than doubled. Increasing the LLD setting can help reduce
some high deadtime effects.

Preset Real Time sets the counting timer to run for actual clocktime and makes no
correction for losses due to deadtime effects.

Click on Settings, click on Presets
Enter the LIVE or REAL time in the correct box. Click on OK, to set adjustment and
exit menu.

Change the man wirdow 1o displey the Dala Repon H300 LT:45 HT:"

Both the LIVE TIME and REAL TIME values are displayed on the UCS20 status bar
as LT and RT. These values are saved in the file during data storage.

IDH_OPPRESETTIME
SPreset Time
Kpreset Time



"*Preset Integral

Preset Count _}ﬂ

Set integral count:

|12345q

E

Cancel |

Set Integral
To set an integral count it is necessary to first establish a ROI and then position the
marker within the region.

Selecting an ROI and setting a value other than O in preset integral will cause the system
to STOP counting when the total of all the channels within the ROI reaches that value.

“IDH_OPPRESETINTEGRAL
SPreset Integral
XPreset Integral



G0, Stop and Erase

Go, Stop and Erase functions are accessed with the Tool Bar buttons. Clicking on Start
begins data collection. Clicking on Stop ends data collection. Clicking on Erase sets each
channel’s data to zero.

“IDH_OPSTARTETC
$G0, Stop, and Erase
KGO, Stop, and Erase



sRegion of Interest (ROI)
I,

Region of interest (ROI) selection is an advanced feature which provides instantaneous
computation of peak gross and net counts. These values may be used along with isotope
decay tables and detection efficiency to calculate absolute or relative isotopic activities.
ROTI’s must not overlap and need to be separated by at least one channel for correct area
calculation. Up to 16 different ROI’s are possible using the color selector from the pull
down Settings menu.

| Sektings
Set ROl
Energy Calibrate P ClearROT
Clear all ROT's
Presets
ArmpiHY D
s
Colors

Select Device

Reset Al Mariables To Defalks

Set ROI

To set an ROI around a peak, click the ROI button on the Tool Bar. Click the left mouse
button at the beginning of the ROI, hold down the left mouse button and drag the marker
to the other side of the peak, release mouse button.

Clear ROI
Move marker to the ROI to be cleared. Open the Setting Menu, open ROI and select
Clear ROL

Gross and Net Count

When the marker is positioned in a region of interest (ROI), the UCS20 software
automatically calculates the Gross and Net area of the region. In order to minimize
statistical effects at the ROI endpoints, a 3-point averaging technique is applied. The
contents of channels (n-1), (n), and (n+1) are summed and averaged to derive the content
of the endpoint channel for the net area computation. A linear interpolation is performed
between these averaged endpoint values and counts below this interpolation are

"IDH_OPROI
$Region Of Interest
KRegion Of Interest



subtracted to arrive at the Net area of the peak. Gross counts is the sum of all channels in
the ROI.

Position the marker in the peak of interest. The Gross and Net areas are automatically
computed and displayed on the spectrum screen.

Preset Integral



s<HFunctions

Energy Calibration
Isotope Matching
Strip Spectrum
Smoothing

“IDH_FUNCTIONS
SFunctions
KFunctions



~Energy Calibration

) | Settings
ROT's v |
Energy Calibrate ncalibrate
Presets L Pt

i 3 Paink

p'”?'?'lleADC At Calibrate
Mz
Zolors

Select Device

Reset fll Wariables To Defaults

The energy calibration feature allows the marker to read directly in energy units. Two
calibration functions are possible, a 2-point linear, or a 3-point quadratic fit.

In order to perform an energy calibration, it is first necessary to acquire a spectrum using
known isotopes. Cs-137 together with Co-60 works well for many applications,
producing gamma lines at 32 keV, 662 keV, 1173 keV and 1332 keV.

Select 2-point or 3-point mode and enter the calibration units to be used, (keV or MeV).
Position the marker at the highest channel of the first peak and enter the peak energy
value. Move the marker to the high point on the second peak to be used for the
calibration, enter energy number. If a 3-point calibration is required, continue by moving
the marker to the peak channel of the third peak, enter its energy and click OK. The
system will now be calibrated and the marker position will read directly in energy.

To return to the channel number mode, click on Settings, click on Uncalibrate.
Energy Calibration may also be selected using the right mouse button.

Emarngy Calibrale E Energy Calibrate B

Energy Lalibratbmn Eaini 1 (=

Charegt |'13 Channal: |H'1

Lirabs: ke ke |34 e [esd
"ok || cancel | Hep | [ ok | cancel | | ok | cancel |

"IDH_FUNCENERCAL
$Energy Calibration
XEnergy Calibration



~]sotope Matching

_&_Spectrum Techmquesz - UCS520 - Live Mod

Fie Edit Mode Display Settings Stip Back

@llﬁll@@lllll@lﬂimnun

Ready HY.B300M  LT:66 RT.75 Device SN:9E

Displaying Isotope Peaks

Isotope peaks may be indicated on calibrated spectra. These peaks are selected from a list
provided by selecting the Display menu and clicking on Iso Match. The following dialog
box will be displayed:

Displey
Paak Rapost
Dieis Raport

» Calibraiion
= Fils
a0 Maich

Pl Sz '

“IDH_FUNCISOMATCH
$Isotope Matching
XIsotope Matching



Show Isotopes _ il

lzatope: Half-Life

Co-E0 827 pears

3 vears
Ba133 10.4 pearsz
b r-54 3122 dayz

14 65 vears
Zn-Bh 2441 dayz

Cancel |

Click the isotopes peaks in the left window that you want to display. These will be
transferred to the right window. When your list is complete, click Okay to display them.

Editing the Iso Match list
Select the Edit menu and click Iso Match. The following dialog box will be displayed:

Edit
Experimant
5o Madch
| S oot Dads
x x
|zotope Half-Life lzotope Half-Life
Co-B0 B.27 pears
Cd-109 1.27 pears
Cz137 30 pearz
Ba132 10.4 pears
b n-hd 2.2 davs
Ma-22 1465 vears
Zn-Bh 2441 dayz
tdd | Delete | EDIT | bdd | Delre | EDIT |
0k | Cancel | 0k | Cancel |

IsoMatch Library NOT loaded. IsoMatch Library IS loaded

The dialog box top window labeled ‘Select an existing isotope’ will be empty unless an
Iso Match library has been loaded. If a library has been loaded, you can select on of the
entries from the window, if a library has not been loaded, or you want to add an entry to



the list, enter the name in the second window titled ‘or enter and isotope name’. Enter the
number of peaks you want to add for this isotope in the third box labeled ‘Enter number
of peaks [10 max]’ and click on Edit.

Further dialog boxes will appear that allow you to enter peak(s) for the isotope.

x
|zotope Half-Life
IES-1 2 IEEI years
Peak Energy [Kek] Abundance
BE1.62 a4 62
3218 hi
Add I Drelete | Edit |
g ] Cancel |

If you want to save the Iso Match to a disk file, open the File Menu and click on Save
Library.



=Strip Background

Strip Background  View  Hel
Lo Specium
I Lioad Background

The Strip Background option is available only in the File Mode. The user may load two
files (Spectrum and Background) and subtract the second file from the first. The portion
subtracted is based on a time adjustment to the data in the second file. For example if the
first file was measured with 100 seconds live time and the second file was measured with
200 seconds live time, then the data in the second file is divided by 2 (200 seconds / 100
seconds) before it is subtracted.

Load Spectrum

Load Background

Show Spectrum

Show Background

Overlay Spectra

Strip Background from Spectrum

Background Subtraction

This is a special case of spectrum stripping. Collect a background sample spectrum,
usually for a long collection time. Load this spectrum as Background and click on ‘Strip
Background from Spectrum.” The live time fraction of the background is subtracted from
spectrum. This provides a convenient method of removing naturally occurring
background from a sample spectrum and can be very useful when working with low level
environmental samples.

"IDH_STRIP
$Strip Background
XStrip Background



"*Load Spectrum

Strip Background  View  Heg
Lo Specirum
I Lioad Backgroind

Click on Load Spectrum and in the File Dialog Box that opens, select the spectrum you
intend to have the background stripped from. For example, the spectrum may be taken for
an isotope, the background may be the readings with no isotope present.

"IDH_LOADSPECTRUM I
$Load Spectrum
XLoad Spectrum



"*Load Background

Strip Background  View  Heg
Lo Specirum
I Lioad Backgroind

Click on Load background and in the File Dialog Box that opens, select the background
you intend to strip from the first. For example, the spectrum may be taken for an isotope,
the background may be readings with no isotope present.

"IDH_LOADSPECTRUM2
$Load Background
¥Load Background



**Show Spectrum

| Stnp Background  View  Help
Lioad Spectrum

I Load Background

¥ Show spectum
S Background

Creerlay Speactnum and Background
Stp Background from Spectrum

Click Show Spectrum to view spectrum.

IDH_SHOWSPECTRUMI1
SShow Spectrum
XShow Spectrum



**Show Background

| Sop Background View  Hedp
Load Spechum
Load Backaround
Sho SRaciTU

# Show Background

overlay Specirum and Background
Sarip Backgroured from Specirum

Click Show Background to view background.

"IDH_SHOWSPECTRUM2
SShow Background
XShow Background



#QOverlay Spectra

_&._Spe-::trum Techniques - UESZI] File Hud -TE5T1 £pu
File Edit Mode Di ] ew  Help

Channel: 511 Energy:
Counts: 5

Ready Hi: 860 LT:6 I File fode

BN

Click Overlay Spectra to view the spectrum and the background at the same time.

"IDH_OVERLAYSPECTRA
$Overlay Spectra
XOverlay Spectra



#kStrip Background from Spectrum

SopBackground  View  Hep
Load Specirum
Load Background

Sho SRaciTU
# Show Background

Crerlay Specirum and Background
Sarip Backgrourd Trom Specirum

Click Strip Background from Spectrum to subtract the two spectra, where the

background is corrected for the difference in the data collection time to give a correct
proportion.

“IDH_STRIPSPECTRUM2FROM 1
$Strip Background from Spectrum
Strip Background from Spectrum



#Data Smoothing

Edit
Experimant
s Maich

S oot Lale

Click Smooth Data to perform a 3-point averaging of the data currently being displayed.
The function uses the following algorithm to average data in each channel, where ‘n’ is
the channel number.

(n-1)+(n)+(n+l) .
3

"IDH_FUNCSMOOTH
SData Smoothing
XData Smoothing



sMenu Bar

Many advanced functions are possible via the pulldown menus. This section describes
each operation in the sequence they appear. Black letters indicate the function is
operational, gray indicates not-operational, highlighted indicates the function the be be
activated.

File- Edit Mode Display Settings StripBackground Wielw  Help

For details:

IDH_MENU
SMenu Bar
KMenu Bar



scHile

| File:
CIpEr. .. ()
Save CEF+S
Load Setup
Save Zetup

Load Isobope Library
Save Isotope Library

Brink. ., iZkrl+P
Print Preview
Print Sefup...

Exit

For details:

File Open

File Save

File Load Setup
File Save Setup
File Load Library

File Save Library
File Print

File Print Preview

File Print Setup
File Exit

IDH_MENUFILE
SFile Menu
KFile Menu



"**File Open

File Open allows the user to open data files. A new instance of the UCS20 application in
the File Mode is generated.

See Also:
Window Live Mode
Window File Mode

“IDH_MENUFILEOPEN
SFile Open
XFile Open



#KHile Save

The spectrum data and the associated setup and experiment data are saved to a *.spu file.

IDH_MENUFILESAVE
SFile Save
KFile Save



"*File Load Setup

Once the UCS20 has been setup and calibrated, all operating parameters may be stored
(Save Setup) as a disk file for subsequent retrieval. If power has been turn off, it is a
simple and convenient process to reload the setup file and quickly restore (Load Setup)
the analyzer to its previous operating condition.

High Voltage must be turned on after loading setup !

“IDH_MENUFILELOADSETUP
SFile Load Setup
XFile Load Setup



"**File Save Setup

Once the UCS20 has been setup and calibrated, all operating parameters may be stored
(Save Setup) as a disk file for subsequent retrieval. If power has been turn off, it is a
simple and convenient process to reload the setup file and quickly restore (Load Setup)
the analyzer to its previous operating condition.

“IDH_MENUFILESAVESETUP
SFile Save Setup
XFile Save Setup



**File Load Library
Allows loading of an Iso Match library file (*.itm).

See also:
Isotope Matching

“IDH_MENUFILELOADLIBRARY
SFile Load Library
XFile Load Library



"kFile Save Library
Allows saving of an Iso Match library file (*.itm).

See also:
Isotope Matching

“IDH_MENUFILESAVELIBRARY
SFile Save Library
XFile Save Library



#KH1le Print

Allows the user to print the displayed spectrum.

IDH_MENUFILEPRINT
SFile Print
KFile Print



#kHile Print Preview

Allows the user to preview the spectrum as it will be printed.

IDH_MENUFILEPRINTPREVIEW
SFile Print Preview
KFile Print Preview



**File Print Setup

Allows the user to adjust the printer parameters before printing.

“IDH_MENUFILEPRINTSETUP
SFile Print Setup
XFile Print Setup



"*File Exit

Closes the application.

"IDH_MENUFILEEXIT
SFile Exit
KFile Exit



~Edit

Edil
Experimant
o Medch

| SemoohDals

For details see:

Edit Experiment
Edit Iso Match

Edit Smooth Data

IDH_MENUEDIT
SEdit Menu
KEdit Menu



KEdit Experiment

Specium Nemsa

Job Test 234-432

Descriplion

[_JEIEIll'l‘lll‘lEl e U OETY | SO
Student IC

[Soky 12345678

Digtactor Lizad

|;u-nn HETEE-n

Comenents

| Femks nchcate thet tis is Cs-177]

] cos_| |

Edit Experiment provides a means of inserting text into spectral file headers for
referencing specific measurements. This text is saved along with data and parameter
information in .SPE and .TSV files, and it is used for the Peak Report and the Data
Report.

Enter the desired text into the dialog box and click Okay when finished.

“IDH_EDITEXPERIMENT
SEdit Experiment
XEdit Experiment



"KEdit Iso Match

Edit Iso Match allows the user to edit isotope data, add and delete isotopes from library.

See also:

Isotope Matching

IDH_EDITISOMATCH
SEdit Iso Match
KEdit Iso Match



"KEdit Smooth Data

Edit Smooth Data allows the user to apply a three-point smoothing algorithm to the
displaed data.

For details see:
Data Smoothing

IDH_EDITSMOOTHDATA
SEdit Smooth Data
KEdit Smooth Data



ssMode

| Moda
# Pulse Haight
1 Ml Channel Scaling
Mossbauer
Exteral MCS
Extimal bdossbmier

For details see:

Mode Pulse Height

Mode Multi Channel Scaling
Mode External MCS

IDH_MENUMODE
SMode
KXMode



**Mode Pulse Height

| Made
v Pulse Height
Multi Channel Scaling
Extermal MCS

Click on Pulse Height to select the Pulse Height Mode.

See:
Pulse Height Analysis

‘IDH_MENUMODEPULSEHEIGHT
SMode Pulse Height
XMode Pulse Height



**Mode Multi Channel Scaling

[ Mode

| Pulse Heighk
v Multi Channel Scaling
| External MCS

Click on Multi Channel Scaling to select the Multi Channel Scaling Mode.

See:
Multi Channel Scaling

"IDH_MENUMODEMCS
SMode Multi Channel Scaling
¥Mode Multi Channel Scaling



**Mode External Multi Channel Scaling

Made

Pulse Height
MUkl Channel Scaling
| v External MCS

Click on External MCS to select the External Multi Channel Scaling Mode.

See:
External Multi Channel Scaling

“IDH_MENUMODEEXTMCS
SMode External Multi Channel Scaling
XMode External Multi Channel Scaling



~Display

Displey
Pank Fapot
[eis Baport

= Lalibraion
* HUls
|50 Maich

Pived Sz~

For details see:

Display Peak Report
Display Data Report
Display Calibration
Display ROIs
Display Iso Match
Display Pixel Size

IDH_MENUDISPLAY
$Display
XDisplay



#$K

Display Peak Report

If regions of interest have been set around peaks in a spectrum, the Peak Report provides
a convenient method of displaying peak information in tabular form. Readout will be in
energy units if the energy calibration is active.

“IDH_MENUDISPLAYPEAKREPORT
$Display Peak Report
XDisplay Peak Report



#$K

Display Data Report

The Data Report includes all hardware setting, counting parameters and spectrum data.
ROI data is reported by lower and upper channels set, gross, net, FWHM, centroid, all
channels and corresponding counts.

“IDH_MENUDISPLAYDATAREPORT
$Display Data Report
XDisplay Data Report



#$KDisplay Calibration

Display Calibration allows the user to switch between on/off in calibration mode and
channel numbers or energy is displayed on the horizontal line.

“IDH_MENUDISPLAYCALIBRATION
s Display Calibration
X Display Calibration



"KDisplay ROIs

Display ROIs lets the user toggle between displaying and not displaying the ROIs.

“IDH_MENUDISPLAYROIS
$Display ROIs
XDisplay ROIs



XDisplay Iso Match

Display Iso Match lets the user toggle between displaying and not displaying the Iso
Match peaks.

“IDH_MENUDISPLAYISOMATCH
$Display Iso Match
XDisplay Iso Match



#$K

Display Pixel Sizes
Display
Paak Rapod
Dimts Raport
+ Calibwatan
« ROls
180 Malch
BEEEDE o
2 Points
3Fpints

Allows the user to choose between 1, 2, and 3 pixels per data point displayed. The default
is 2.

“IDH_DISPLAYPIXELSIZES
$Display Pixel Sizes
XDisplay Pixel Sizes



=Settings

Settings ! Settings
! ROI's 3 M ROIs
| :

! Energy Calibrate (2 Energy Calibrate
Presets 2 Presets
.ﬁ.mp,!'H'-.-',l'.ﬁ.D!C ArnpHY A0
MGS TS
Colors Colars
Select Device Select Device
Reset Al Yariables To Defaults Reset All Varisbles To Defaults

In Preset mode In MCS mode
ROIs
Clear ROIL
Set ROI
Presets

Preset Time
Preset Integral

Amp/HV/ADC
High Voltage
Amplifier Coarse Gain
Amplifier Fine Gain
ADC Conversion Gain

lower and Upper Level Discriminators

"IDH_MENUSETTINGS
$Settings Menu
XSettings Menu



"kSettings ROIs

| Settings
FOl's Seb ROT
Energy. Calibrate b ClearROI

Clear all ROT's

Presets
AmpHY IADC
i [
Colors

Select Device

Reset Al ariables To Defalks

Allows the user to select the option to set or clear an ROI.

See:
Clear ROI
Set ROI

IDH_MENUSETTINGSROIS
$Settings ROIs
KSettings ROIs



"KClear ROI

| Sattings
ROI's ek RO
Energy Calibrate P ClearROT

Clear All ROT's

Presets
AmpHY ADC
s
Colars

Select Device

Reset fll Mariables To Defaulks

Clicking on Clear ROI will clear the ROI indicated by the marker.

"IDH_MENUSETTINGSROICLEARROI
SClear ROI
KClear ROI



"KSet ROI

| Sattings
ROI's ek RO
Energy Calibrate P ClearROT

Clear All ROT's

Presets
AmpHY ADC
s
Colars

Select Device

Reset fll Mariables To Defaulks

Clicking on Set ROI allows the user to set the ROI.

See also:

Region of Interest (ROI)

"IDH_MENUSETTINGSROISETROI
$Set ROI
KSet ROI



"XSettings Energy Calibrate

) | Settings
ROT's v |
Energy Calibrate ncalibrate
Presets L Pt

7 3 Paink

p'”?'?'llemc Auta Calibrate
Mz
Colors

Select Device

Reset all Yariables To Defaults

Opens a submenu for calibrating and uncalibrating the spectrum.

See:

Settings Energy Uncalibration
Settings Energy Calibrate 2 Point
Settings Energy Calibrate 3 Point

“IDH_MENUSETTINGSENERGYCALIBRATE
$Settings Energy Calibrate
XSettings Energy Calibrate



#$#Settings Energy Uncalibrate

Clicking Energy Uncalibrate will undo energy calibration and return the spectrum to the
channel mode of data display.

See:
Energy Calibration

“IDH_MENUSETTINGSENERGYUNCALIBRATE
$Settings Energy Uncalibrate
#Settings Energy Uncalibrate



#$KSettings Energy Calibrate 2 Point
Clicking 2-Point allows the user to calibrate the date using two points.

See:
Energy Calibration

“IDH_MENUSETTINGSENERGY2POINT
$Settings Energy Calibrate 2 Point
XSettings Energy Calibrate 2 Point



#$KSettings Energy Calibrate 3 Point
Clicking 3-Point allows the user to calibrate the date using three points.

See:
Energy Calibration

“IDH_MENUSETTINGSENERGY3POINT
$Settings Energy Calibrate 3 Point
KSettings Energy Calibrate 3 Point



#$KSettings Preset
Clicking Presets allows the user to select the Presets Dialog box.

See:
Preset Time

Preset Integral

“IDH_MENUSETTINGSPRESET
$Settings Preset
KSettings Preset



"KSettings Amp/HV/ADC

Clicking Amp/HV/ADC allows the user to select the Amp/HV/ADC Dialog box.

See:

Amp/HV/ADC
High Voltage
Amplifier Coarse Gain
Amplifier Fine Gain
ADC Conversion Gain

lower and Upper Level Discriminators

"IDH_MENUSETTINGSAMP/HV/ADC
SSettings Amp/HV/ADC
XSettings Amp/HV/ADC



#$KSettings MCS

Clicking MCS allows the user to access the MCS Dwell Time dialog box, if the Mode is
set to MCS.

Craall Tima
I'II.'I'.I'll*: ﬂ -_--f:':'.---!

Scroll to the desired Dwell Time then highlight the value selected then press OK.

See:
Multi Channel Scaling

IDH_MENUSETTINGSMCS
$Settings MCS
KSettings MCS



#$KSettings Color

Clicking Color allows the user to select the Colors Dialog Box to set or change the
colors for the ROIs, Background, .

RO 2
Hil 3
ROl 4
Rl S
ROIG
ROl?
HJl |
ROl
Ra

Rl 11
sl 1A :J

Sample

Change | FI.n:m.ﬁ-.II|

Ok, Cancal | Hedp |

The Color Dialog Box allows the user to select custom colors for ROIs, Plot
Background, Plot Border and Text.

Select the item to change, click on Change, select the desire color, click on OK, returns
to the Color screen, make additional color changes, when all color changes have been

made, click on OK, enters data and returns to spectrum screen.

Color allows the user to select a range of Basic Colors or create Custom Colors.

"IDH_MENUSETTINGSCOLOR
$Settings Color
KSettings Color



[l [n]]

Emsic coloes:

1111111
T I

Custom colors:

R
T ua

Define Custom Colars 33 |

o | oo |

Dialog Box with standard Colors.

Basic colons:

11 HEEEAT
| 11T IHRERT

o e e e L e s

ok | conesl

4

- i —

setfi  Geenfl

ColoriSghd |y i Bige: I
Add 1o Custom Colors

Dialog Box expanded for custom colors.

Note:

Setup of computer graphic may affect the true color of the color selected.



#$KStriP Background

| Sirp Background  View  Help
Lioad Spectrum
Liosad Backgrord

¥ Show spectum
S Backgroundd

Creerbny Spectium and Background
Stp Background from Spectrum

Allows the user to load a spectrum and a background and then strip the background from
the spectrum.

See:
Strip Background

"IDH_MENUSTRIP
$Strip Background
KStrip Background



#$KStrip Background - Load Spectrum

See:
Load Spectrum

“IDH_STRIPLOADSPECTRUMI
$Strip Background — Load Spectrum
XStrip Background — Load Spectrum



#XStrip Background - Load Background

See:
Load Background

“IDH_STRIPLOADSPECTRUM?2
$Strip Background — Load Background
Strip Background — Load Background



#XStrip Background - Show Spectrum

See:
Show Spectrum

“IDH_STRIPSHOWSPECTRUM I
$Strip Background — Show Spectrum
XStrip Background — Show Spectrum



#XStrip Background - Show Background

See:
Show Background

“IDH_STRIPSHOWSPECTRUM?2
$Strip Background — Show Background
XStrip Background — Show Background



#XStrip Background — Overlay Spectra

See:
Overlay Spectra

“IDH_STRIPOVERLAYSPECTRA
$Strip Background — Overlay Spectra
XStrip Background — Overlay Spectra



#XStrip Background — Strip Background from Spectrum

See:
Strip Background from Spectrum

“IDH_ASTRIPSPECTRUM2FROM 1
$Strip Background — Strip Background from Spectrum
Strip Background — Strip Background from Spectrum



sV1ew

e
| Toalber
Shatus Bar

Allows the user to display or not display the Tool Bar and/or the Status Bar.

Tool Bar
Status Bar

IDH_MENUVIEW
SView
Kyiew



"KTool Bar

Allows the user to display or not display the Tool Bar.

IDH_MENUVIEWTOOLBAR
$Tool Bar
KTool Bar



#KStatus Bar

Allows the user to display or not display the Status Bar.

IDH_MENUVIEWSTATUSBAR
SStatus Bar
KStatus Bar



#$KHelp

Hslp
Coniess
LJ=ing Halp

dboard LACSAD.

The Help menu provides a convenient operator reference for the UCS20 in the standard
Windows Help format.

IDH_MENUHELP
$Help Menu
XHelp Menu



“KContents

The Help menu provides a convenient operator reference for the UCS20 in the standard
Windows Help format.

IDH_MENUHELPCONTENTS
SContents
KContents



#$K

Using Help

The Using Help item provides the standard Windows Help on using the Windows Help
system.

“IDH_MENUHELPUSINGHELP
$Using Help
XUsing Help



K About

Displays a splash screen with the Application name and version number.

IDH_MENUHELPABOUT
S About
K About



=Tool Bar
O WHE RO

BE N AV 3 EE

ROI

Spectrum Window Sizing
Y axis Increase

Y axis Decrease

Y axis Log

X axis expand

X axis contract

X axis right 256 channels

X axis right 16 channels
X axis left 16 channels

X axis left 256 channels

IDH_TOOLBAR
$Toolbar
KToolbar



)
Go allows the user to start the acquire mode of a spectrum. This can also be

accomplished by clicking on the green start icon on the display screen.

See:
Go. Stop and Erase

IDH_TBGO
Go Button
X Go Button



#$KSt0p

Stop allows the user to stop the acquire mode of a spectrum. This can also be
accomplished by clicking on the red stop icon on the display.
See:

Go. Stop and Erase

"IDH_TBSTOP
$Stop Button
X Stop Button



s<Hrase

&P

Erase allows the user to erase the spectrum when in stop mode. This can also be
accomplished by clicking on the Eraser Icon on the display screen.
See:

Go. Stop and Erase

“IDH_TBERASE
SErase Button
KErase Button



*Show Peak Report

If regions of interest have been set around peaks in a spectrum, the Peak Report provides
a convenient method of displaying peak information in tabular form. Readout will be in
energy units if the energy calibration is active.

“IDH_TBSHOWPEAK
SShow Peak Button
KShow Peak Button



*Show Data Report

Data Report includes all hardware setting, counting parameters and spectrum data. ROI
data is reported by lower and upper channels set, gross, net, FWHM, centroid, all
channels and corresponding counts.

IDH_TBSHOWDATA
SShow Data Button
KShow Data Button



sAmp/HV/ADC

Allows the user to select the Amp/HV/ADC Dialog box.

See:

Amp/HV/ADC
High Voltage
Amplifier Coarse Gain
Amplifier Fine Gain
ADC Conversion Gain

lower and Upper Level Discriminators

IDH_TBAMPHVADC
SAMP/HV/ADC Button
KAMP/HV/ADC Button



sPresets

Q=

Allows the user to select the Presets Dialog box.

See:
Preset Time

Preset Integral

“IDH_TBPRESETS
SPresets Button
Kpresets Button



#$KROI

Allows the user to set an ROI.

See:
Region Of Interest
IDH_TBROI

$Region Of Interest Button
X Region Of Interest Button



#*Spectrum Window Sizing

These buttons allow the user to set the size of the X and Y axes.

If a button is grayed, its function is not available for use.

"IDH_SPECTRUMWINDOW
$Spectrum Window
XSpectrum Window



®KY axis Increase

Clicking the Y axis increase button doubles the magnitude of the Y axis.

IDH_TBYINC
%Y axis increase Button
K'Y axis increase Button



®KY axis Decrease

Clicking the Y axis decrease button halves the magnitude of the Y axis.

IDH_TBYDEC
%Y axis decrease Button
KY axis decrease Button



Y axis Log

Clicking the Y axis Log button sets the Y axis to a logarithmic scale with a maximum of
16 meg.

"IDH_TBYLOG
SY axis Log Button
XY axis Log Button



KX axis expand

Clicking the X axis expand button increases the span of the X axis, up to the maximum
set by the Conversion Gain.

"IDH_TBXEXP
SX axis expands Button
XX axis expands Button



HKX axis contract

Clicking the X axis contract button decreases the span of the X axis.

“IDH_TBXCONT
$X axis contract Button
KX axis contract Button



"X axis right 256 channels

Active if there are 256 channels to the right of the displayed X axis span. Clicking this
button will shift The X axis span 256 channels to the right.

"IDH_TBXR256
SX axis right 256 channels Button
XX axis right 256 channels Button



kX axis right 16 channels

Active if there are 16 channels to the right of the displayed X axis span. Clicking this
button will shift The X axis span 16 channels to the right.

"IDH_TBXR16
SX axis right 16 channels Button
XX axis right 16 channels Button



KX axis left 16 channels

Active if there are 16 channels to the left of the displayed X axis span. Clicking this
button will shift The X axis span 16 channels to the left.

“IDH_TBXL16
$X axis left 16 channels Button
KX axis left 16 channels Button



KX axis left 256 channels

Active if there are 256 channels to the left of the displayed X axis span. Clicking this
button will shift The X axis span 256 channels to the left.

IDH_TBXIL.256
$X axis left 256 Button
KUSC20 Topics



#=Status Bar

Ready [Hy:570 SN [LT:15 [RT:20 [Device SH:6

The status bar at the bottom of the window displays a context sensitive help message on
the left side, the high voltage, live time, real time, and selected device on the right side.

IDH_STATUSBAR
IDH_SBHV
IDH_SBLT
IDH_SBRT

SStatus Bar Button
KStatus Bar Button



=Specifications

Hardware
Software

"IDH_SPECIFICATIONS
$Specificati0ns
KSpecifications



s<Hardware

Physical: Single instrument includes preamplifier, amplifier, detector high voltage,
2048-channel multichannel analyzer with data memory, LLD and ULD. Fully compatible
with many scintillation detectors and commercial tube bases.

Amplifier:  On-board combination preamplifier/amplifier for use with scintillation
detectors and PMT's. Computer controlled coarse and fine gain from (x) 1 to (x) 160.
ADC: Wilkinson type with 80 MHz clock and computer selected convrsion gain of
2048,1024. 512, or 256 channels. Direct input accepts pulse peaking times of 1 usec. to
10 psec. Includes dead-time correction when used in Live-time mode.

LLD & ULD: Independently computer controlled in 4-channel increments over entire
input range. Operates prior to ADC for reduced system dead time.

Modes: MCA for pulse height analysis, or MCS for half-life decay or other time
related studies.

Timers: Real-time or Live-time operation selectable in 1-second increments for
PHA, or dwell times from 10 msec. to 600 seconds per channel in MCS mode.

Data Memory: On-board static RAM, 2048 channel (x) 3 Bytes for data, plus
region-of-interest flag.

Deadtime:  System dead-time is computed and displayed on screen during acquisition.
Power: AC line powered with an auto sensing power supply for 100 — 250 VAC,
10 watts total.

Connections On Rear Panel:

Connections On Rear Panel

“IDH_SPECHW
SHardware Button
XHardware Button



s«Software

System: Operates under Microsoft Windows® 98, Windows® 2000, Windows®
XP with 600 kb for the executable and 5 meg for the optional help file available disk
space, 32 meg RAM (48 recommended), and compatible mouse.

Display: VGA or SVGA color graphics (800x600 recommended. Vertical scale
adjusts from 32 to 16M and LOG display. Horizontal 2048 channels with reduction down
to 256 channels.

Time Mode: Preset live-time or preset real-time selection. Both times are recorded and

displayed.
ROI'S: Multiple Regions-of Interest using color coding.
Integral: When cursor is in ROI, computes gross area, net area with end point

averaging, centroid and FWHM.

Energy Cal: 2-point linear or 3-point quadratic converts cursor position reading
directly to energy units. (Time units in MCS mode.)

Strip: Subtracts channel-by-channel time normalized data stored in File Mode. Overlays
two saved spectra in File Mode

Smooth: 3-point smoothing of selected displayed data.
Control: Software control of High Voltage, Amplifier Gain, Lower and Upper level
discriminators, and ADC Con- version Gain.

File: Save or load data file and header information in binary, or spreadsheet compatible
formats.

Print: Prints current screen display to Windows printer.

ROI File: Saves ROI data, centroid, FWHM, gross and net integrals, and header
information in spreadsheet compatible format.

ISOMATCH: Isotope library text file with peak markers and labeling for overlaying on
spectrum for quick isotope identification. Library may be edited from Edit, IsoMatch pull
down menu.

“IDH_SPECSW
$Software Button
KSoftware Button



#$KSpectrum Techniques Contact

SPECTRUM TECHNIQUES, INC.
106 Union Valley Road
Oak Ridge, TN 37830
USA
Tel. (865) 482-9937 Fax. (865) 483-0473
e-mail: support@spectrumtechniques.com
Web Site: http://www.spectrumtechniques.com

"IDH_SPECTECHCONTACT
$Spectrum Techniques Contact
XSpectrum Techniques Contact
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